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Status Lights Window

The status lights window lists all the resources, their local drive letters, and available disk space,
along with status lights which indicate the state of the connection with the monitored drive and 
the amount of space remaining on the monitored drive.    The Status Lights screen consists of 
the following areas:

Resource Name
Drive Letter
Connection
Space
Available K
Status Screen Menu

Use the View menu options to change from status lights to status gauges.



Status Gauges Window
The status gauges screen shows all the resources currently being monitored in a gas gauge 
style format.    This screen is a parent window which contains within it a child window for each 
resource.    Each child window contains the following elements:

Resource Name.    The resource name and local drive letter are displayed in the child windows 
title bar.

Disk Usage Status Gauge.    The disk usage status gauge takes up most of the child window.    It
resembles a gas gauge in an automobile, with the letters E and F denoting Empty and Full.    A 
needle on the gauge indicates the drives current usage level.

Available K.    At the bottom of each child window is an area where the amount of free space on 
the drive is displayed.    It can be different colors depending on the configured Warning and 
Critical Levels.

The Status Gauges parent window consists mostly of an empty area on which the child windows
are positioned.    It also contains the Status Screen Menu.

Use the View menu options to change from status gauges to status lights.



Configuration Window

The Configuration Window is where you enter the Resource Names, Drive Letters, Warning 
Levels, Critical Levels, and Check Frequencies of the drives you want to monitor.    You can 
enter up to 16 resources to watch.

The Configuration Window contains three push buttons:    OK, Save, and Cancel.

This screen also contains the Configuration Window Menu



Message Window

When you activate one or more of the following choices from either the Status Lights Window or
the Status Gauges Window menu, the message window opens and any status messages 
generated by DiskWatcher are placed there:

Message on Warning
Message on Critical
Message on Lost Connection

The following situations will generate a message if their options are checked on the menu:

Drive becomes unavailable (lost connection)
Available space falls below warning level set for that drive
Available space falls below critical level set for that drive

Each message includes the date and time to indicate when the status change occurred.

Only 255 messages can be placed in the message window by DiskWatcher.    After that, one 
more message will be placed in the message window, to the effect that the message window is 
full.    For a complete record of all messages, you should log the messages to a log file.

Closing the message window clears out all current messages.



Definitions

C
Check Frequency
Child Window
Critical Level

D
Desktop
Drive Letter

E
Edit Box

L
Local Name

M
Menu

P
Parent Window
Push Button

R
Resource Name

S
Spin Button
Status Gauge
Status Light

W
Warning Level



Error Messages

The following are error messages which may be generated by DiskWatcher:

The error log file you specified in the WIN.INI file is an invalid file name.    To correct this error, turn off 'Log Errors to 
File' then turn it on again, and specify a valid file name.    Next, close the DiskWatcher program and restart it.

The configuration file you specified on the command line could not be found.

Error number   nn   occurred while loading the configuration file you specified on the command line.  

Path   cfg file name   not found.  

Path   log file name   not found.  

Error number   nn   occurred.  

No room to insert.    Delete a row first.

You must enter a value into the Drive Letter field.

You must enter a value into the Warning Level field.

You must enter a value into the Critical Level field.

You must enter a value into the Check Every field.

You must enter a numeric value greater than 0 in the Warning Level field.

You must enter a numeric value greater than 0 in the Critical Level field.

You must enter a numeric value greater than 0 in the Check Every field.

The following are status messages which may be generated by DiskWatcher:

resource name   has fallen below Warning Level.  

resource name   has fallen below Critical Level.  

resource name   unavailable or connection lost.  



Program Overview

DiskWatcher is a Windows program that allows you to monitor the availability of and free space 
on disk drives.    It is intended for use primarily to monitor network disk drives, but can easily be 
used on standalone workstations.

You can configure the program to monitor specific disk resources and alert you when these 
resources become unavailable or when free space falls below preset warning and critical levels. 
Configuration is done at the Configuration Window.

DiskWatcher lets you monitor your drives in two ways:    status lights or gauges.

When at the status lights screen, you are presented with a list of resources and indicator lights 
which show the connection status and the free space status for each resource.    This screen 
also shows you the number of kilobytes of available space on each monitored drive.

The DiskWatcher gauge screen presents you with a parent window which contains inside it a 
child window for each resource being monitored.    Each child window contains a gas gauge and
the number of kilobytes of available space on the monitored drive.



Release History

First release, version 1.0, May 1993



Known Bugs and Limitations

Known Bugs

None reported as of yet.

Limitations

1.    The DiskWatcher program can only monitor 16 drives.    If you are on a network and wish to 
monitor more than 16 drives, you can run more than one DiskWatcher session on one 
workstation.

2.    Make sure the amount you enter for Warning Level is greater than the amount you enter for 
Critical Level in the Configuration Window.



Copyright Notice

DiskWatcher disk drive monitor program
Copyright    1993, Backwoods Software

Portions Copyright    1985-1992, Microsoft Corporation



Status Window Menu

Both the Status Lights Window and the Status Gauges Window have identical menus.    The 
menus in the status windows are as follows:

File
Load Configuration...
Configure Resources...
Exit DiskWatcher

View
Lights
Gauges

Options
Beep on Warning
Beep on Critical
Beep on Lost Connection
Message on Warning
Message on Critical
Message on Lost Connection
Log Messages to File...

Help
Contents
Search...
Help on Help
About DiskWatcher...



Configuration Window Menu

The Configuration Window menu provides you with the necessary functions for loading, saving, 
and editing your configurations.    It has the following options:

File
New Configuration
Load Configuration...
Save Configuration
Save Configuration As

Edit
Cut
Copy
Paste
Insert Row
Delete Row

Helphelp
Contents
Search...
Help on Help
About DiskWatcher...



Resource Name

A resource name is your designation for a specific disk drive.    This field isn't actually used by 
the program except as a comment, so you can put anything you want in it.    However, it should 
be a meaningful name.    On a standalone PC, it can be something as simple as My drive C:.    
For a network device, though, you should use the device's network name.

For example, in a Microsoft LAN Manager/IBM LAN Server type environment, you will probably 
want to use the UNC name (sharename), such as \\srvrname\x$.    For other networks, such as 
Novell Netware, you'll probably want to use the server name and the device name.    If you have 
a server called MKTNG with a shareable drive called CDRIVE, you could enter something along
the lines of MKTNG CDRIVE.

When entering this field in the Configuration Window, you may enter as many characters as you
want, but for practicality it's best to keep it under 20 characters.    All characters are valid in this 
field.    This field cannot be blank if the other fields in the row have data in them.

When an error occurs, such as the drive connection being lost or space falling below critical or 
warning level, the resource name is included in the error message written to the Message 
Window or error log file, if you have activated these options on the Status Screen Menu.



Drive Letter (Local Name)

The drive letter is your computer's name for a disk device.    On a standalone workstation, the 
drive letter is the local hard drive's actual letter designation, such as C:, D:, or E:.    On a 
networked workstation, this is the shared device's local name.    For instance, if server 
ADMSUPT drive CDRIVE is mapped to your workstation's L: drive, L: would be the drive letter 
you'd enter in this field in the Configuration Window.

You can enter up to two characters in this field, but only the first character is actually used by 
the program to check the drive's status.



Connection

The Connection light is an indicator of whether or not your workstation can see the drive it is 
supposed to be monitoring.    For instance, if your L: drive is mapped to a server resource and 
that server goes down, you'll lose your connection to the resource.    This light will indicate that 
such an event has occurred.

The Connection light can be one of three colors-green, red, or white.    If this light is green, the 
connection is good.    If it is red, your workstation has lost its connection.    If the light turns white,
an error has occurred within the DiskWatcher program itself.    If the Connection light is red or 
white, the Space light is disabled (grey).

If you have the Beep on Lost Connection option active, your computer will emit a short beep 
every time the program checks for the drive and cannot find it.

If you have the Message on Lost Connection option active, the program will add an error 
message to the list in the Message Window whenever this situation occurs.

If you have the Log Messages to File option active, the program will append the error message 
to the log file you've specified.



Space
The Space light is an indicator of how much free space exists on the drive being monitored.    Its
color is based on the amounts you entered in the Critical Level and Warning Level fields in the 
Configuration Window.

If the drive's free space is greater than the amount you entered in the Warning Level field, the 
light will be green.    If the remaining space is less than or equal to the Warning Level, but 
greater than the Critical Level, the light will be yellow.    If the remaining space is less than or 
equal to the Critical Level value, the light will be red.

If the Connection light is red or white, the Space light will be disabled (grey).    If the Space light 
turns white, an error has occured within the DiskWatcher program itself.



Available K

This value shows the actual amount of space free on the monitored drive, in kilobytes.    On the 
Status Light screen, this information is on the right side of the screen.    If this information is not 
available because of a lost connection or an error, this area will be blank.    On the Status Gauge
screen, this information is displayed at the bottom of each child window, directly beneath the 
gauge.    If this information is not available because of a lost connection or an error, the words 
DRIVE UNAVAILABLE will be displayed in red letters.



Warning Level

The warning level is an amount, in Kbytes, you enter into the Configuration Window for each 
resource you wish to monitor.    If you have the Status Lights screen displayed, the Space light 
for a drive will turn yellow if the space available on the drive falls below this amount, but above 
the Critical Level amount.    If you have the Status Gauges screen displayed, the amount of 
available space will be displayed in yellow.

If you have the Beep on Warning option active, your computer will emit a short beep every time 
the program checks the drive and finds it at or below the warning level.

If you have the Message on Warning option active, the program will add an error message to 
the list in the Message Window whenever this situation occurs.

If you have the Log Messages to File option active, the program will append the error message 
to the log file you've specified.

Enter only a numeric value in this field; otherwise, an error message will result.



Critical Level

The critical level is an amount, in Kbytes, you enter into the Configuration Window for each 
resource you wish to monitor.    If you have the Status Lights screen displayed, the Space light 
will turn red if the space available on the drive falls below this amount.    If you have the Status 
Gauges screen displayed, the amount of available space will be displayed in red.

If you have the Beep on Critical option active, your computer will emit a short beep every time 
the program checks the drive and finds it at or below the critical level.

If you have the Message on Critical option active, the program will add an error message to the 
list in the Message Window whenever this situation occurs.

If you have the Log Messages to File option active, the program will append the error message 
to the log file you've specified.

Enter only a numeric value in this field; otherwise, an error message will result.



Check Frequency

Check frequency is the number, in minutes, which represents how often the program should 
update the monitored resources statistics.    The minimum time you can enter into this field is 
one minute.    You can use the spin button to adjust the check frequency, or you can enter it 
manually.

Enter only a numeric value in this field; otherwise, an error message will result.



Status Light

A status light is a round indicator on the Status Lights Window which resembles a warning light 
on a piece of electronic equipment.    It changes its color as the state of the monitored hard drive
changes.    Two status lights are shown for each resource name--the Connection Light and the 
Space Light.



Status Gauge

A status gauge is a dial-and-needle type gauge much like a gas gauge or speedometer in an 
automobile.    In the Status Gauges Window, each resource name has its own child window 
which contains the status gauge for that resource.    The status gauge is marked to indicate 1/4, 
1/2, and 3/4 full, and also has E and F at the ends of the dial to indicate empty and full.



Child Window

A child window is a window which is subordinate to another window, known as a parent window. 
Child windows, when open, appear inside the parent window; when minimized, their icons 
appear within the parent window, rather than at the bottom of the desktop.



Parent Window

A parent window is a window on the desktop which can contain within it one or more 
subordinate windows, known as child windows.    When a parent window is closed, all child 
windows within it are also closed.



Spin Button

A spin button is a type of control which is placed adjacent to an edit box which allows you to 
change the value in the edit box without removing your hand from the mouse.    The spin button 
has two arrows; clicking one increases the value in the edit box, while clicking the other 
decreases it.



OK Button

In the Configuration Window, the OK push button tells DiskWatcher to use the new configuration
youve entered and takes you back to either the Status Lights Window or the Status Gauges 
Window, whichever you were in when you selected Configure Resources... from the Status 
Screen Menu.

If you have made changes and havent saved them with the Save push button, DiskWatcher will 
ask you whether or not you want to save.    You will be presented with three choices:    Yes, No, 
and Cancel.

If you select Yes, the program will save the changes to the configuration file currently in use.    If 
you are not using a configuration file, DiskWatcher will display a File Save As dialog box so you 
can enter a configuration file name.

If you select No, the program will not save the changes to the configuration file, but DiskWatcher
will return you to the Status screen from whence you came, and it will use the new configuration
values.

If you select Cancel, the changes will not be saved, and you will not return to the Status screen.



Save Button

In the Configuration Window, the Save push button tells DiskWatcher to save the new 
configuration youve entered to a disk file.    If you arent currently using a configuration file, 
DiskWatcher will display a File Save As dialog box so you can choose or enter the file name 
under which you want to save the configuration.

If, after you press Save, you press OK, the program will take you back to the Status Screen 
from whence you came and use the new configuration.    However, if you press Cancel after you 
save, the new configuration will still be saved in the configuration file, but DiskWatcher will take 
you back to the Status Screen and use the old configuration information.



Cancel Button

In the Configuration Window, the Cancel push button tells DiskWatcher to take you back to the 
Status Screen from whence you came, without using any new configuration information you 
may have entered.    In other words, it discards any changes you have made.    However, if you 
have saved the changes, the new configuration information will still be in the configuration file.



Beep on Warning

To access this setting, select Options/Beep on Warning from the menu of whichever status 
screen you are currently viewing.    If this option is active, there will be a check mark beside it on
the menu.    This option causes the DiskWatcher program to beep whenever the program 
detects that available space on a monitored drive has fallen below the warning level.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Beep on Critical

To access this setting, select Options/Beep on Critical from the menu of whichever status 
screen you are currently viewing.    If this option is active, there will be a check mark beside it on
the menu.    This option causes the DiskWatcher program to beep whenever the program 
detects that available space on a monitored drive has fallen below the critical level.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Message on Warning

To access this setting, select Options/Message on Warning from the menu of whichever status 
screen you are currently viewing.    If this option is active, there will be a check mark beside it on
the menu.    This option causes the DiskWatcher program to place a message in the message 
window whenever the program detects that available space on a monitored drive has fallen 
below the warning level.    If the message window isn't open, the program opens it.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Message on Critical

To access this setting, select Options/Message on Critical from the menu of whichever status 
screen you are currently viewing.    If this option is active, there will be a check mark beside it on
the menu.    This option causes the DiskWatcher program to place a message in the message 
window whenever the program detects that available space on a monitored drive has fallen 
below the critical level.    If the message window isn't open, the program opens it.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Beep on Lost Connection

To access this setting, select Options/Beep on Lost Connection from the menu of whichever 
status screen you are currently viewing.    If this option is active, there will be a check mark 
beside it on the menu.    This option causes the DiskWatcher program to beep whenever the 
program detects that a monitored drive has become unavailable.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Message on Lost Connection

To access this setting, select Options/Message on Lost Connection from the menu of whichever 
status screen you are currently viewing.    If this option is active, there will be a check mark 
beside it on the menu.    This option causes the DiskWatcher program to place a message in the
message window whenever the program detects that a monitored drive has become 
unavailable.    If the message window isn't open, the program opens it.

This setting is stored in the WIN.INI file, under the [DiskWatcher] section heading.



Log Messages to File

To access this setting, select Options/Log Messages to File from the menu of whichever status 
screen you are currently viewing.    If this option is active, there will be a check mark beside it on
the menu, and the name of the log file will be in parentheses.

This option causes the DiskWatcher program to place a message in the log file whenever the 
program detects that a monitored drive has become unavailable, dropped below the warning 
level, or dropped below the critical level.



Desktop

The desktop is the screen space occupied by Windows.    You can visualize your monitor screen
as a type of desk.    Just as with a real desk, you can move things around, put new things on it, 
take old things off, and rearrange it as you please.



Edit Box

An edit box, also know as a text box, is a space into which you type information.    It is usually 
surrounded by a thin border.    When a text box is the active control, it has a special type of 
cursor known as an insertion point which resembles a flashing vertical bar.    Any characters you 
type will be inserted at that point.



Push Button

A push button, also known as a command button, causes an action to occur immediately.    To 
activate it, you click on it with the mouse.



Menu

A menu is a list of commands from which you can choose to initiate an action or take you to a 
different place in the program.    Menus are arranged in a line across the top of the applications 
window.



Configuration File

The DiskWatcher configuration file is a text file which contains the information about the 
resources you wish to monitor.    The information is taken from the Configuration Window and 
written to this file.    The default extension for this file is INI.



View Menu

The View menu is accessed from the menu of either Status Screen.    It switches you between 
the Status Lights Window and the Status Gauges Window.

The current monitor screen will have a checkmark beside it.    To switch from one view to the 
other, simply select the one you want.



Configure Resources...

The Configure Resources... option is accessed from the menu of either Status Screen.    
Selecting this choice takes you to the Configuration Window, where you can enter the resource 
names, drive letters, warning levels, critical levels, and check frequency of the drives you wish 
to monitor.



Configuration Window File Menu

The File Menu in the Configuration Window contains the functions which allow you to create, 
load, and save configuration files:

New Configuration
Load Configuration
Save Configuration
Save Configuration As



New Configuration

This option in the Configuration Window file menu erases all the resource configuration 
information on the screenin essence, allowing you to start over with a clean slate.    If you have 
made changes but haven't saved them, you'll be given the option of saving before it erases the 
data.



Load Configuration

This option in the Configuration Window file menu presents you with a File Open dialog box in 
which you can choose the configuration file to load.    Once you do so, DiskWatcher erases the 
information currently in the Configuration Window, reads the configuration information from the 
file, and puts it on the screen.

If you have made changes before selecting this option, but haven't saved them, the program will
give you the opportunity to do so before it overwrites them.



Save Configuration

This option in the Configuration Window file menu saves the configuration information on the 
screen into a configuration file.    If the information in the Configuration Window was loaded from
a file, it will be saved back to the same file.    If, however, you are not working from an existing 
configuration file (for instance, you selected File New to clear the screen), you will be prompted 
for a file name when you choose this option.



Save Configuration As

This selection in the Configuration Window file menu allows you to save your configuration 
information under a new file name.    When you select this option, the Save File As dialog box 
will appear, allowing you to choose the name you would like the information saved under.



Configuration Window Edit Menu

The Edit Menu in the Configuration Window contains options which allow you to manipulate 
data you've entered into the various fields on the screen.    They are:

Cut
Copy
Paste
Insert Row
Delete Row



Cut

The Cut option in the Configuration Window Edit Menu removes selected (highlighted) text from 
an edit box and places it on the Clipboard.    Pressing Ctrl+X has the same effect.



Copy

The Copy option on    the Configuration Window Edit Menu copies selected (highlighted) text 
from an edit box into the Clipboard.    It leaves the text in the edit box intact.    Pressing Ctrl+C 
has the same effect.



Paste

The Paste option in the Configuration Window Edit Menu takes text from the Clipboard and 
places into the currently selected edit box at the insertion point.    Pressing Ctrl+V has the same 
effect.



Insert Row

The Insert Row option in the Configuration Window Edit Menu inserts an empty row into the 
Configuration Window at the row where the text cursor is located, and pushes the current row of
information and all other rows down one.    If the Configuration Window is full or the 16th row 
already has information in it, this function will not work.



Delete Row

The Delete Row option in the Configuration Window Edit Menu deletes the row of information 
where the cursor is currently located and moves all subsequent rows up one.



Help Menu

The Help Menu contains selections which offer information on how to use the program, how to 
use Windows, and copyright information.    It contains the following choices:

Contents
Search
Help on Help
About DiskWatcher



Contents

Selecting Contents from the Help Menu brings you to the help information you are using now.    
It starts you out at the Table of Contents and lets you explore from there.



Search

Selecting Search from the Help Menu takes you to a screen which allows you to enter a 
keyword to search for.    Once you enter a keyword, Help shows you all the topics under which 
that keyword appears.    You can then select the topic and view it.



Help on Help

Help on Help displays the Windows help file which teaches you how to use Windows help.



About DiskWatcher

Selecting About DiskWatcher from the Help Menu displays an "About" box, which gives the 
name of the program, its icon, version number, and author, as well as copyright information.



Status Window File Menu

The Status Window File Menu contains three options:

Load Configuration
Configure Resources
Exit DiskWatcher



Load Configuration

Selecting this option from a Status Window File Menu brings up the File Load dialog box from 
which you can choose the configuration file which contains the information about resources you 
want to monitor.



View Lights

Selecting this option from the Status Gauges Window switches you to the Status Lights Window.
If you are already in the Status Lights Window, selecting this option has no effect.



View Gauges

Selecting this option from the Status Lights Window switches you to the Status Gauges Window.
If you are already in the Status Gauges Window, selecting this option has no effect.



Exit DiskWatcher

Selecting Exit DiskWatcher from a Status Window File Menu closes the DiskWatcher application
and returns you to the Program Manager desktop.



Options Menu

The Status Window Options Menu contains the selections which determine how DiskWatcher 
notifies you of a change in the status of a monitored resource.    When an option is selected, a 
check mark appears to the left of it in the menu.

Beep on Warning
Beep on Critical
Beep on Lost Connection
Message on Warning
Message on Critical
Message on Lost Connection
Log Messages to File



Selected Text

Selected text is text that has been highlighted in order to have some operation performed on it.   
You can select text in one of two ways, once the cursor has been placed into the edit box which 
contains the text you want to select:

1. With the insertion point at the beginning of the text you want to select, hold down the 
shift key and move the insertion point with the arrow keys until the text you want is highlighted.

2. With the mouse, click on the beginning of the text you want to select and hold the mouse
button down as you move the mouse cursor to the end of the text you want to select.



Error log file specified in WIN.INI not found.

This error will usually occur for one of two reasons:

The log file name specified in the WIN.INI file has been manually edited and the name 
entered doesn't exist.

The log file specified in the WIN.INI file was deleted from or moved out of the default 
directory prior to running DiskWatcher.



Configuration file specified on the command line not found.

When you start DiskWatcher, you can specify a configuration file name on the command line.    
DiskWatcher will automatically load that configuration and monitor the resources specified in it.   
If you specify a non-existent configuration file (or, perhaps, misspell the name), you'll get this 
error message.



Error number nn occurred while loading the configuration file specified on the command 
line.

When you start DiskWatcher, you can specify a configuration file name on the command line.    
DiskWatcher will automatically load that configuration and monitor the resources specified in it.   
This message indicates that an error occurred for an unknown reason and gives the error 
number.    This error number is useful when obtaining technical support.



Path cfgfilename not found.

You will receive this message if you attempt to load a non-existent configuration file, or if you 
specify an invalid file name while loading or saving a configuration file.



Path logfilename not found.

You will receive this message if you attempt to open a non-existent message log file, or if you 
specify an invalid file name while opening a message log file.



Error number nn occurred.

This message indicates that an error occurred for an unknown reason while loading or saving a 
log or configuration file and gives the error number.    This error number is useful when obtaining
technical support.



No room to insert.    Delete a row first.

You attempted to insert a row in the configuration window, but all rows were already full.    This 
can also occur if the last (16th) row has data in it, whether or not the rows above it do.



You must enter a value into the Drive Letter field.

This message indicates that you have a partially-completed row in the Configuration Window, 
but have failed to enter the drive letter of the resource you wish to monitor.



You must enter a value into the Warning Level field.

This message indicates that you have a partially-completed row in the Configuration Window, 
but have failed to enter the Warning Level amount for the resource you wish to monitor.



You must enter a value into the Critical Level field.

This message indicates that you have a partially-completed row in the Configuration Window, 
but have failed to enter the Critical Level amount for the resource you wish to monitor.



You must enter a value into the Check Every field.

This message indicates that you have a partially-completed row in the Configuration Window, 
but have failed to enter the check frequency amount in the Check Every field for the resource 
you wish to monitor.



You must enter a numeric value greater than 0 into the Warning Level field.

This message indicates that you have an invalid amount in the Warning Level field.    Make sure 
you have a number greater than or equal to 1 in this field.



You must enter a numeric value greater than 0 into the Critical Level field.

This message indicates that you have an invalid amount in the Critical Level field.    Make sure 
you have a number greater than or equal to 1 in this field.



You must enter a numeric value greater than 0 into the Check Every field.

This message indicates that you have specified an invalid value for the check frequency in the 
Check Every field.    Make sure you have a number greater than or equal to 1 in this field.



resource name has fallen below Warning Level.

If you have the Message on Warning option checked in the Status Window menu, this message 
will be placed in the message window every time DiskWatcher checks the specified drive and 
finds that its free space is at or below the warning level you indicated in the configuration.



resource name has fallen below Critical Level.

If you have the Message on Critical option checked in the Status Window menu, this message 
will be placed in the message window every time DiskWatcher checks the specified drive and 
finds that its free space is at or below the critical level you indicated in the configuration.



resource name unavailable or connection lost.

If you have the Message on Lost Connection option checked in the Status Window menu, this 
message will be placed in the message window every time DiskWatcher attempts to check the 
specified drive and finds that it can't.






